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Introduction 
Binary Ninja is a powerhouse reverse engineering suite that provides a plethora of functionality 
that is useful when reverse engineering malware. It has a robust Python API for interacting with 
abstractions (semantic representations) generated by their multiple levels of Binary Ninja 
Intermediate Languages (BNILs). These abstractions result in large simplifications of 
disassembled instructions into intrinsic functions and high level languages that can be 
accessed directly and easily, which we will be leveraging throughout this workshop.


This workshop will use Binary Ninja to acquire information needed to deobfuscate and extract 
a Qakbot sample from its packed form.


Setup 
For the Binary Ninja components of this workshop, you will need a personal, commercial or 
enterprise version of Binary Ninja. This will give you access to the Python API that we will be 
using to extract information from the Binary Ninja database.


In addition to Binary Ninja, we will be using two Python modules to extract a resource from the 
packed binary (https://github.com/erocarrera/pefile) and carve embedded Portable 
Executables (https://github.com/binref/refinery).


To add these modules in Binary Ninja, perform the following steps:


• Press CMD/CTRL+P to open the command palette and type in “Install python3 
module”, which will highlight this command within the command palette window, as shown 
in Figure 1.


• Press Enter to bring up the Install python3 modules window, as shown in Figure 2.


Figure 1. Install Python 3 Module Palette Option

Figure 2. Modules Window

https://binary.ninja/
https://docs.binary.ninja/dev/bnil-overview.html
https://docs.binary.ninja/dev/bnil-overview.html
https://github.com/erocarrera/pefile
https://github.com/binref/refinery
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• Enter the following modules and press install:


pefile>=2023.2.7 
binary-refinery>=0.6.38 

This will install these dependencies in your Binary Ninja Python directory.


Plugin Install


We will be using a plugin called Snippets to visualize and execute the automation scripts that 
we will be writing. To install this plugin, navigate to the plugin manager by clicking on the 
Plugins->Manage Plugins menu item. This will open a new Manage Plugins tab, as 
shown in Figure 3.


In the search box type in Snippet UI Plugin. Once displayed, right click the Snippet UI 
Entry and click on Install Plugin, as shown in Figure 4.


Figure 3. Plugin Manager

Figure 4. Snippet UI Plugin Installation



 of 5 21 © Invoke RE 2024

In addition to the Snippet plugin, install the HashDB plugin written by Cindy Xiao.


We will be dealing with real malware samples. We will not be executing these, but if your 
system has antivirus it may pick up the packed or unpacked samples in these exercises. 
Please proceed with caution if you are using your host system. 

Now that all required dependencies and plugins are installed, clone the workshop repository 
from GitHub using git clone https://github.com/Invoke-RE/workshops. This 
repository contains the baseline automation scripts and samples that we will be using 
throughout this workshop under recon2024. Unzip the samples.zip with the password 
“infected” and open 
780be7a70ce3567ef268f6c768fc5a3d2510310c603bf481ebffd65e4fe95ff3 in 
Binary Ninja using File->Open… and selecting it from the file explorer dialogue.


HLIL and Scripting with Binary Ninja 
Once the sample has been loaded and processed by Binary Ninja, the user interface will 
navigate to the _start function (AddressOfEntryPoint from the PE header) and display 
the High Level Intermediate Language (HLIL) representation of this function (Figure 5).


We will be leveraging HLIL throughout this workshop to acquire a decompiled representation of 
instructions at a level similar to IDA Pro’s Hex Rays and Ghidra. 

To view the disassembled equivalent of this HLIL code, select the Split View icon in the top 
right-hand corner (Figure 6).


Figure 6. Split View Icon

Figure 5. _start Function in HLIL Representation
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This will split the view into two vertical panes, as shown in Figure 7.


Change the instruction representation using the dropdown above the left pane (currently set to 
High Level IL) to Disassembly, as shown in Figure 8.


This displays the instructions in their disassembled form within this pane, as shown in Figure 9.


Figure 7. HLIL Split View

Figure 8. Select Disassembly View Dropdown

Figure 9. Disassembled _start Function
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The HLIL view attempts to provide a representation that can be semantically understood in the 
same way as a programming language, rather than solely relying on disassembled instructions. 
Having each representation side-by-side has multiple benefits. The first is that the 
disassembled instructions can be referenced inline with the HLIL in order to understand the 
recovered instructions more thoroughly. The second is that there are instances where the HLIL 
representation is inaccurate, and therefore the only guaranteed method of understanding the 
functionality correctly is to read the disassembled instructions.


Now that we have the HLIL and disassembly for the sample, let’s take a look at interacting with 
the database using the Binary Ninja Python API. Binary Ninja provides a Read-Eval-Print Loop 
(REPL) Python console that provides code completion and a number of other useful 
functionality. Display this console using the Console button in the bottom left of the screen 
(Figure 10).




The STDOUT and STDERR outputs from the Snippet plugin will be written to the Log view. Open 
the Log view by clicking on the Log button in the bottom right of the screen (Figure 11).


We can interact directly with the database using the BinaryView (or bv) through the Python 
console. For example, we can acquire the list of functions that have been discovered by Binary 
Ninja using bv.functions. This returns a generator, so we can acquire a list of these 
functions using list(bv.functions), as shown in Figure 12.


Figure 10. Python Console Button

Figure 11. Log View Button 
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We can acquire all HLIL instructions from the database using bv.hlil_instructions. This 
also returns a generator, so we can acquire the first HLIL instruction, for example, using 
list(bv.hlil_instructions)[0], as shown in Figure 13.


In this example, the HLIL instruction is of type HighLevelILVarInit, because it is a variable 
that’s being initialized by the memory allocation being performed. We can traverse these 
instructions by accessing its operands, as shown in Figure 14.


Here we can see this instruction is made up of a variable and a HighLevelILCall to 
malloc. If we wanted to access the size of the memory allocation, for example, we could 
access the malloc instruction at its index and access this instruction’s operands, as shown in 
Figure 15.


Figure 12. Function List from BinaryView

Figure 13. Get First HLIL Instruction in Database

Figure 14. Get HLIL Instruction Operands
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Traversing the HLIL in this manner can be cumbersome. We can use a built-in helper function 
called traverse to recursively walk the abstract syntax tree (AST) of this instruction to look for a 
constant and return its value once found. This is done by providing a callback function that’s 
called on each sub-instruction within the HLIL instruction. The return value of each callback is 
returned within a generator from the traverse call. An example of this is shown in Figure 16.


The above example has the prerequisite of knowing that the type of value we’re seeking from 
the instruction is a HighLevelILConstant. Since typing function definitions and other 
complex code into a REPL isn’t ideal, this is where the Snippet editor plugin comes in. Open 
the Snippet editor by going to Plugins->Snippets->Snippet Editor… and click on the 
New Snippet button, as shown in Figure 17.


Figure 15. Get Malloc Allocation Size from HLIL Representation

Figure 16. Traverse HLIL Recursively using Helper Function

Figure 17. New Snippet Button

https://api.binary.ninja/binaryninja.highlevelil-module.html#binaryninja.highlevelil.HighLevelILFunction.traverse
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This will open the Snippet Name window, as shown in Figure 18.


Enter the name get_const.py and click OK. A new Snippet will be opened and we can now 
write our script here. Copy the code from get_const.py into this snippet, as shown in Figure 
19.


Ensure your High Level IL pane is selected and click on the Run button in the Snippet Editor, 
and you will see the same result is displayed in the Log view, as shown in Figure 20.


Figure 18. Snippet Name

Figure 19. get_const Snippet Example

Figure 20. Result from Running Snippet
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Qakbot Unpacking Stub 
Now let’s look at the unpacking code in this Qakbot sample and extract information from it that 
we can use to automatically unpack it. Packers typically have an outer program (commonly 
referred to as a stub) that deobfuscates a final malware payload that is executed in memory. 


The sample we are analyzing in Binary Ninja 
(780be7a70ce3567ef268f6c768fc5a3d2510310c603bf481ebffd65e4fe95ff3) is the 
stub that decrypts position independent shellcode that decrypts, loads and executes a final 
Qakbot payload in memory. The stub extracts the encrypted shellcode ciphertext from an 
embedded resource and decrypts it using a basic XOR cipher. In this workshop we will be 
writing code to automatically extract the decryption key and the resource from the stub, 
decrypt the shellcode and carve the final Qakbot payload from it.


From the _start function you will see a call to sub_691bc000 (Figure 21).


Navigate to this function by double-clicking on sub_691bc000 for further analysis.


Within the disassembly pane, you can see a large amount of mov operations, as shown in 
Figure 22.


Figure 21. Call to sub_691bc000

Figure 22. Large Amount of Mov Operations
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The bytes are moved into local variables that are relative to the stack pointer (RSP) and are 
within the ASCII range. Select any of these hex bytes and press the r key to turn them back 
into their ASCII representation. An example is shown in Figure 23.


This is a technique known as “stack strings” where a string is constructed on the stack 
dynamically at runtime. This is an obfuscation technique that prevents recovery of strings using 
simple techniques, such as running the strings utility.


Even though this technique is used, the Binary Ninja HLIL simplifies this into a single 
__builtin_strncpy operation (Figure 24).


The __builtin_ prefix specifies that this is an “intrinsic” which means the instruction is 
inferred from the mov operations being performed. Select the destination variable (var_148) in 
order to display the cross-references in the Cross References pane (Figure 25).


Figure 23. Character Change to ASCII Representation Example

Figure 24. __builtin_strncpy Operation

Figure 25. var_148 Cross References
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The third entry (highlighted in red) shows a number of operations being performed with this 
string. Double-click on this entry to navigate to this location (0x691bc72b). A number of 
operations are performed within a for loop with the result being written to rax_25 (Figure 26).


This includes an XOR operation with a byte from the var_148 string (Figure 27).


A modulus operator is being applied to the current index, which causes the index to not 
exceed the length of var_148. Based on these operations, we can infer that the var_148 
string is an XOR key being used to decrypt a buffer within rax_24 and the result is written to 
rax_25 . We then see rax_25 being executed as a function pointer (Figure 26), which results 
in the decrypted bytes being executed.


We can rename these variables by highlighting the variable name and pressing the n key. This 
will display the Define name dialogue where a variable name can be entered (Figure 27).


Rename var_148 to xor_key, rax_24 to input_buffer and rax_25 to shellcode. By 
looking at the operations above the for loop, we can see the input_buffer and shellcode 
pointers are the result of two function calls that use unknown function pointers (Figure 28).


Figure 26. rax_25 Operations within For Loop and Shellcode Execution

Figure 27. var_148 XOR Operation

Figure 27. Define Variable Name

Figure 28. Input Buffer and Shellcode Initialization
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Import Hash Resolution 
These function pointers are assigned the return values of calls to sub_691bcd90 (Figure 29).


The sub_691bcd90 function performs dynamic import resolution, which is a technique often 
used by malware and shellcode to resolve Windows API functions at runtime. This involves 
parsing in-memory structures in order to resolve the addresses of particular functions that are 
required for the malware to execute.


This process requires resolution of the module (in this case kernel32) containing the function, 
and then the export table of the resolved DLL is walked in order to identify the address of the 
target function. Malware authors will often use hashing algorithms to iterate over each function 
that is parsed in memory, hash each function name and compare it against the hash of a 
desired function to resolve.


In this instance, the second parameter being passed to sub_691bcd90 is the hash being 
resolved, whose resolved function pointer is then assigned to a local variable that is later called 
where needed. We can automatically identify the hashing algorithm using a plugin called 
hashdb, which queries an online database that contains precomputed hashes that map to 
common strings, such as Windows API function names.


The second parameter passed to sub_691bcd90 is the hash that is being resolved by this 
function. We can confirm this by right-clicking on the first hash (0xe3142) and going to 
HashDB->Hunt, as shown in Figure 30.


Figure 29. Function Pointer Initialization

Figure 30. HashDB Hunt for Hash

https://github.com/cxiao/hashdb_bn
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This will query HashDB for this hash, and “hunt” for any hashing algorithms that have 
produced this hash. In this instance, a number of hashing algorithms are found, as shown in 
Figure 31.


This particular hash was produced by a number of different hashing algorithms that are stored 
in HashDB. Select the shl1_add algorithm, as shown in Figure 31, and click OK. This will set 
the hashing algorithm to shl1_add as shown in the Log window (Figure 32).


Now that the hashing algorithm has been identified and set, we can query HashDB for each 
hash by right-clicking on 0xe3142 and selecting HashDB->Hash Lookup. This will display 
the String Selection window, as shown in Figure 33.


This will provide a dropdown of strings that correspond to the provided hash. It is common to 
have hashing collisions (the same hash for two different strings) from these simple algorithms, 
so this may involve some trial and error. However, in this instance, VirtualAlloc is correct. 
Click OK to add the selected string to the Binary Ninja database as an enum.


Figure 31. HashDB Hunting Results

Figure 32. Hashing Algorithm Set

Figure 33. String Selection from Hash Value
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In addition to the String Selection window, you will be presented with the Bulk Import 
window that will allow you to add all export function string hashes related to a particular 
module (DLL) as an enumeration to the database. This will allow related function names to be 
applied to other hashes that make use of the same hashing algorithm within the database. The 
VirtualAlloc export is contained within a number of different modules. Select kernel32 
from the dropdown, as shown in Figure 34, and click OK.


Now that all hashes for kernel32 have been imported, we can apply them to each hash by 
pressing the m key. For example, select 0xe3142 in the HLIL view and press the m key to 
display the Select Enum window for the VirtualAlloc enum member (Figure 35).


Press the Select Enum button to apply this enum member to the selected hash. This will then 
be displayed in the HLIL view (Figure 36).


Figure 34. Bulk Import Kernel32 Exports

Figure 35. Select VirutalAlloc Enum Member

Figure 36. Applied VirtualAlloc Enum Member
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Hash Resolution Exercise


Rename sub_691bcd90 to mw_resolve_hash using the n key and apply enums to the 
remaining hashes using the m key. The result should look something like Figure 37.


Given that mw_resolve_hash returns function pointers, rename each variable using the n key 
to each respective function being resolved. The result should look something like Figure 38.


As you can see, things are beginning to take shape now that we can see which Windows API 
functions are being called. A handle to a resource embedded within the binary is acquired 
using FindResourceA, the size of the resource is acquired using SizeofResource and the 
resource is loaded using LoadResource with the result being assigned to input_buffer. 
The second parameter of FindResourceA is lpName which is used to identify the embedded 
resource. This value is stored within var_100. Selecting var_100 shows a cross-reference for 
this variable at the beginning of this function where it is initialized (Figure 39).


Figure 37. Resolved Enumerations Applied and Function Renamed

Figure 38. Assigned Variable Names to Pointers

Figure 39. var_100 Initialization Cross-Reference 
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Rename var_100 to rsrc_id for readability. In order for us to extract the final Qakbot 
payload, we need to extract the rsrc_id to identify which resource we need to extract from 
the PE and extract the xor_key to decrypt the embedded resource. We will do this 
programatically using the Binary Ninja API.


XOR Key Identification and Extraction 
We can acquire all HLIL instructions for our target function (sub_691bc000) using:


list(bv.get_function_at(0x691bc000).hlil.instructions) 

We can then enumerate these instructions and look at the first call to __builtin_strncpy 
using the following (see extract_qakbot.py):


finstr = None 
addr = 0x691bc000 
func = bv.get_function_at(addr) 

for instr in func.hlil.instructions: 
    for token in instr.tokens: 
        if '__builtin_strncpy' == token.text: 
            finstr = instr 
    if finstr: 
        break 

if finstr: 
    # Access second operand of __builtin_strncpy 
    key_param = finstr.params[1] 
    #Access constant data from parameter 
    key = bytes(key_param.constant_data.data) 

Here we enumerate all text tokens that make up each HLIL instruction and look for the 
__builtin_strncpy operation. We can then access the second parameter of the 
__builtin_strncpy instruction and acquire the data using the following code:


if finstr: 
    # Access second operand of __builtin_strncpy 
    key_param = finstr.params[1] 
    #Access constant data from parameter 
    key = bytes(key_param.constant_data.data) 

This will acquire the key data in byte format that we can use to decrypt the embedded 
resource.


Resource Extraction and Decryption 
The resource identifier assignment comes after the call to __builtin_strncpy, as shown in 
Figure 40.


Figure 40. Resource Identifier Assignment
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We can access this instruction by adding to the current HLIL instruction’s index using the 
following code:


list(func.hlil.instructions)[finstr.instr_index+1] 

Here we are accessing the __builtin_strncpy’s index and using that to acquire the next 
instruction in the list of all HLIL instructions within the function.


Resource Identifier Extraction Exercise

Now that we have the resource identifier instruction, use the techniques described in the HLIL 
and Scripting with Binary Ninja section to acquire the resource identifier constant value and 
add it to extract_qakbot.py.


Resource Extraction using PEFile

Once the resource identifier has been acquired, we can use it to extract the resource using a 
module called pefile. The pefile module allows parsing and accessing PE structures and 
attributes, including resources. We can access the resource using the following:


def extract_resource(fpath, rsrcid): 
    rsrc_data = None 
    pe = pefile.PE(fpath) 
    pe_mapped = pe.get_memory_mapped_image() 
    for rsrc in pe.DIRECTORY_ENTRY_RESOURCE.entries: 
        for entry in rsrc.directory.entries: 
            if entry.struct.Name == rsrcid: 
                rsrc_offset = 
entry.directory.entries[0].data.struct.OffsetToData 
                rsrc_size = 
entry.directory.entries[0].data.struct.Size 
                rsrc_data = pe_mapped[rsrc_offset:rsrc_offset + 
rsrc_size] 
    return rsrc_data 

This function accesses IMAGE_DIRECTORY_ENTRY_RESOURCE data directory entries of the 
provided PE and compares each entry’s name to the acquired resource identifier. The pefile 
module allows accessing PE data in its mapped format using the 
get_memory_mapped_image function. This is used to acquire the resource data with the 
identified resource offset and resource size.


Resource Decryption

We can now decrypt the extracted resource data by performing a rotating XOR decryption with 
the extracted key from the XOR Key Identification and Extraction section and the following 
code:


def xor(key: bytes, ct: bytes) -> bytes: 
    r = bytes() 
    for i, b in enumerate(ct): 
        r += (b ^ key[i % len(key)]).to_bytes(1, 'little') 
    return r 

https://github.com/erocarrera/pefile


 of 20 21 © Invoke RE 2024

This results in plaintext shellcode that maps an embedded PE into memory and executes it. 
This first stage PE contains another PE that is our final Qakbot payload.


Carving Portable Executables 
In order to carve all embedded PE files, we can use Binary Refinery, which is “a collection of 
Python scripts that implement transformations of binary data such as compression and 
encryption”. Binary Refinery is often thought as a command-line version of CyberChef, which 
provides data transformations used by malware analysts to recover and deobfuscate 
information. We will be using Binary Refinery to carve embedded PE files from a given data 
blob using the carve_pe module using the following code:


def carve_pe(data: bytes) -> list: 
    from refinery import carve_pe 
    # This syntax is specific to Binary Refinery's 
    # operator overloading and is valid Python. 
    carved = data | carve_pe | [] 
    return carved 

Here this function makes use of Binary Refinery’s pipe format to pipe our resource data into the 
cave_pe module, which will look for, acquire the size of and extract a portable executable 
from the provided blob and return this within a list. As mentioned, since this blob contains two 
embedded PE files, we need to call this function twice using the following code:


first_pe = carve_pe(pt)[0] 
second_pe = carve_pe(first_pe)[0] 

The second PE is then written to disk using the following code:


fw = open(F"{path}_qakbot.bin", "wb") 
fw.write(second_pe) 
fw.close() 

Save the opened Binary Ninja database by pressing CMD/CTRL+s (in order for our script to find 
the binary file on disk) and run extract_qakbot.py in the Snippets editor.


Testing Against Another Sample 
Open the 
12094a47a9659b1c2f7c5b36e21d2b0145c9e7b2e79845a437508efa96e5f305 sample 
in Binary Ninja and navigate to the sub_180005556 function. This is the same type of 
unpacking function identified in the first sample that we analyzed (Figure 41).


Figure 41. Unpacking Stub Key Copy and Resource Identifier

https://github.com/binref/refinery
https://github.com/gchq/CyberChef
https://binref.github.io/#refinery.carve_pe
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Replace the addr variable value with this address (0x180005556) and run the script. Since the 
function contains a __builtin_strncpy call followed by the resource identifier variable 
assignment, the script automatically identifies these values, extracts them, decrypts the 
embedded resource and writes the final payload to disk. 


Generically Identifying XOR Key and Resource ID 
A generic version of the script is provided extract_heuristic_generic.py. Since we do 
not want to manually identify the function containing these values for every packed sample, we 
want to establish a heuristic for identifying these functions.


Since the __builtin_strncpy intrinsic is not called frequently, we can look for this within 
the database as a starting point. We can acquire the address of the this function using 
bv.get_symbol_by_raw_name('__builtin_strncpy').address  which resolves this 
symbol to the virtual address within the database. We can then get the cross-references to this 
address using bv.get_callers(addr).


We can then verify that we have the correct call location by acquiring all HLIL instructions for 
the function and ensuring the instructions following this call are an integer assignment and 
variable declaration:


rsrc_instr = list(c.function.hlil.instructions)[c.hlil.instr_index+1] 
var_init_instr = list(c.function.hlil.instructions)
[c.hlil.instr_index+2] 
if isinstance(rsrc_instr, HighLevelILVarInit) \ 
    and isinstance(rsrc_instr.operands[1], HighLevelILConst) \ 
    and isinstance(var_init_instr, HighLevelILVarDeclare): 
    return c.function 

Developing these heuristics typically requires identifying unique attributes that can be used to 
enumerate locations needed to extract information. Here we’ve simply used the two types of 
HLIL instructions that follow our target location, which is unique to this function.


Conclusion 
This workshop has demonstrated common automation techniques that can be used by 
analysts to access information from binaries using Binary Ninja and deobfuscate them using 
plugins and Python modules. Although these types of tasks are common, malware samples 
often require custom automation to be written for them, but the general concepts can be 
applied across many malware families. Additionally, the automation can be applied to multiple 
malware samples that have been obfuscated using the same techniques in order to extract 
information from them automatically, which drastically saves time and manual analysis efforts.
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